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Editorial Policy
The purpose of this Style Guide is to provide a handy reference to the OMH style
preferences. These may vary slightly from book to book, and the preferences of the
author may sometimes take precedence over the house style.

Strategic, restrained editing is our policy. A change should be made only when you
are absolutely certain that it does not change the author’s meaning. Query if you are
unsure.

In general, Osborne prefers a conversational tone. Clear, easy-to-understand
writing should always be the primary objective. Before beginning the edit, determine
who the intended audience is and what the preferred writing style is for the book
series. (Some series require a more chatty or more serious style than others; consult
with the project editor (PE) if in doubt.) An author’s voice and tone should be allowed
to stand, query your project editor for clarification.

Be particularly careful of computer terminology. Do not change a word just because
it sounds odd. Many of these terms are acceptable in computer material and have
specific meanings. Be watchful, however, for clichés or needless jargon.

In addition to this Style Guide, the following references should be consulted as
needed:

■ The Chicago Manual of Style, 14th Edition

■ Webster’s Collegiate Dictionary, Tenth Edition

■ Microsoft Press Computer Dictionary, Third Edition

■ Computer Desktop Encyclopedia, version 13.5 (PEs’ supplementary resource)

General Guidelines

Queries
Queries should be addressed to the author and should always be tactful, clear, and to
the point. Phrase your queries so that it’s obvious when you are requesting clarification
or a rewrite rather than just a “Yes” or “No” answer. You can use Word’s highlighting
feature to mark areas to be reviewed by the author. Don’t break paragraphs with queries.

I, We, and You
Use of the first person (“I,” “we”) is acceptable, but it should be used consistently. The
reader should be addressed as “you.” Avoid examples that mix references to “you”
and “I” or “you” and “the user.”

Passive Voice
Active voice is preferred although passive voice can be acceptable. Change voice only
when you’re sure you’re not changing the meaning of the sentence.
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Awkward Wording
The primary objective should always be readability rather than following sometimes
arcane rules of grammar. Some long-held rules have given way to simpler, more
natural forms, such as the following:

■ Split Infinitives It is acceptable to split infinitives as long as the intended
meaning remains clear:

to quickly access the File menu, …
to access the File menu quickly, …

■ Sentences Ending with Prepositions Sentences ending in prepositions do not
need to be recast. For example, “The e-mail message indicates whom it was
intended for” needn’t be recast as “The e-mail message indicates for whom it
was intended.”

Objectionable Text and Art
The use of humor and sardonic tone is acceptable, and in the case of some series—such
as the more consumer-oriented ones—it may be intended as part of the series profile.
Insensitive jokes and insulting comments, however, should be queried diplomatically
as something that might potentially offend readers. Religious references in text and art
(other than in the Dedication, Introduction, and Acknowledgments) should be flagged
and discouraged. Sexual references in text and art should be queried to the PE.

Gender-Neutral Language (and Plural Third Person)
Nonsexist language is McGraw-Hill’s policy. Use “you” or “they” whenever possible.
The author may use “he or she” or may alternate between using “he” or “she” in
various examples. Either usage is acceptable as long as the overall effect is
gender-balanced.

It is becoming more common to use the plural third person (“they”) in place of “he
or she,” and if the author prefers this form, it is acceptable to let it stand.

Tone
Lively writing is a primary goal, but overly casual or flip language should be avoided.
This is especially true in the case of headings and captions, which should be
informative rather than entertaining. The tone should be readable but should not
interfere with the reader’s ability to find information quickly and easily.

Dates
To avoid dating a book, dates in the future should be used when example dates are
necessary. Flag past dates in text and art for the PE.
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References
References to books should include the full title and author, as well as the publisher
and date of publication in parentheses, as shown here:

Quicken 2000: The Official Guide by Maria Langer (Osborne/McGraw-Hill, 2000)

References to other parts of the book or chapter should give the specific part or chapter
number, appendix letter, or section heading, as in these examples:

…as discussed in Chapter 13 Not… …as discussed later in this book

And

…as discussed in the earlier
“Using HTML” section

Not… …as discussed earlier in the chapter

Osborne’s standard cross-references do not cite the chapter title.

Preceding/Following
“Preceding” or “following” should be used in references to text that precede or follow
the reference. Avoid using “above” and “below.”

Consistency
The copyeditor should strive to maintain consistency in both style and tone throughout
the manuscript, particularly in books that have multiple authors. Menu names and key
names, for example, should be consistent throughout (e.g., INS and DEL keys should not
become INSERT and DELETE later in the book). If menu or field names change midway
through an edit, as sometimes happens with beta books, notify the PE that the change
will need to be addressed in previously edited chapters.

Special Treatment of Words
Use quotation marks for words as words; for example:

It is unlikely that you would encounter “factotum” in programming code.

Use italics for emphasis and the first use of a term when the term is defined. Also,
italicize letters as letters; for example:

The s in EGAs is not capitalized.

Possessives
Add only an apostrophe to denote the possessive of a word ending in s or z, as in
“users’ passwords.” Whenever possible, avoid using the possessive for inanimate
objects. For example, instead of “the program’s icon” use “the program icon.”
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Product Names and Trademarks
Product names should be spelled and capitalized as indicated by the manufacturer or
on product packaging. Punctuation that is part of the product name (such as Yahoo! or
E*TRADE) can be considered trademark graphics and need not be used in text.

Trademarks (™) and register marks (®) need to be used only in the title and
half-title pages, colophon, and other front matter. They may, however, be used in text,
but only at the first occurrence of the product name.

Lists
In general, numbered lists are used for sequential steps. Bulleted lists are used for
listing items, even if the preceding text refers to a specific number of items. For
example:

Follow these steps: Not… Follow these steps:

1. Open the dialog box.

2. Make a selection.

■ Open the dialog box.

■ Make a selection.

And

There are two options: Not… There are two options:

■ Cutting

■ Copying
1. Cutting

2. Copying

Listings
Do not make changes to code listings without querying first; this is true even for
spelling errors. Code listings lines should be not end in a hard return until the final
line, and tabs are not allowed in code listings or anywhere alse in the manuscript. Code
line length is dependent upon the book design; check sample pages.

Figures and Illustrations1

Figures are artwork that are referred to by number in the text and are set with captions.
They are not set inline and may be referred to more than once. Figure captions should
be short descriptive sentences or phrases (not just labels):

bad caption Figure 1: The Open dialog box

good caption Figure 1: Opening your document in Word

G e n e r a l G u i d e l i n e s 7
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1 See the “Design Elements” section for more information on figures, illustrations, and tables.
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Illustrations are generally smaller art elements that are set inline, are not referenced
in text by numbers, and do not have captions. If an illustration is referred to repeatedly,
it should be changed to a figure and numbered accordingly.

Tables
There are two types of tables: pickup (captioned) and inline (noncaptioned). Pickup
tables are numbered and are referred to by number in the text. Inline tables are
generally shorter than pickup tables. They run inline in the text and are not numbered.
Table captions are usually written like a heading rather than a full sentence:

Table 1: Table Caption for Use as Example

Chapter Summaries
If the author includes chapter summaries, they should be included in every chapter
(with the exception of an introductory chapter).

Punctuation and Type Fonts

Commas
Use the serial comma:

Tom, Jim, and Alice
A:, B:, or C: drive

Colons
Do not use a colon after an inflected verb, as in

The filenames are

■ autoexec.bat

■ init.exe

Ellipses
Ellipses (…) should be indicated with the MS Word key combination, CTRL-ALT-. (period).
See Chicago 10:48-62 for usage.

Periods
When all text columns of a list or table end in incomplete sentences, do not use periods
at the end of the final phrase in an entry:
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CTRL-H Opens the Help menu

CTRL-K Opens the Keyboard menu

CTRL-P This option is only available in Graphics mode. Opens the Print menu

But if even one ending sentence is complete, put periods in all:

CTRL-H Opens the Help menu.

CTRL-K Opens the Keyboard menu.

CTRL-P Opens the Print menu. This option is only available in Graphics mode.

It’s best, however, to avoid inconsistencies by recasting the phrase/sentence for more
parallel construction.

Punctuation in Captions and Callouts
Any complete sentences in captions or callouts should end with a period. If callouts
include both complete sentences and incomplete sentences, don’t add periods to all for
the sake of consistency.

Quotation Marks, Placement of Punctuation Within
Put commas and periods inside of quotation marks except in code. Commas and periods
should also go outside quotation marks surrounding nonletter keyboard characters.
Use smart quotes (“ ”) and apostrophes (‘ ’)—not primes (" ')— for all noncode text.

Punctuation Following Boldface or Italics
Because boldface is used most often to denote user input, punctuation should be
boldfaced only if it is part of the user input. If it is not, it should be in regular face.

Commas and periods following italics normally are italic, but all other punctuation
marks (; : and so on) are not. Do not italicize a comma when it is separating
placeholders to be keyed in, such as

copy (drive, filename) Not... copy (drive, filename)

In this situation, the placeholders are to be replaced with actual names, but the
comma will be typed in as it is.

See also the “Acronyms” section.
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Boldface
Boldface is typically used to indicate user input; for example:

Enter 3 in the Margin field and Budget in the Column Heading field.

Boldface may also be used to indicate functions or commands. Check with the author
or PE.

Italics
Use italics for emphasis and the first use of a term when the term is defined. Italics are
also used for letters as letters; for example:

The s in EGAs is not capitalized.

Refer to Chicago 6.82 for further information.
Italics are also commonly used to indicate variables and parameters, although some

authors prefer other styles. Check with the author or PE.

Small Caps
Small caps are used for keypresses (TAB, SHIFT, F3, SPACEBAR, etc.) and A.M./P.M.

Monospaced Font
Monospace font is used for code listings and may be used for segments of code in text.
Do not surround monospace code in text with quotes. If quotes are contained with the
code set in monospace, be sure they are prime quotes (' or "). To ensure accurate
translation to Courier, PEs should prep the manuscript using the Quotes macro.

Capitalization

Heads
Generally, all conjunctions, articles, and prepositions with five letters or fewer are
lowercased, as in these examples:

about, among, and, but, from

Exception: If a head ends in a preposition, the preposition should be initial capped:

(1)What Is this Book About?

Retain lowercasing of a word in a head when it is a programming term or variable
that normally appears lowercase, even if it is the first word:
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(3)stdio.h and Other Common Files

Use initial cap for prepositions that go with the verb, and for both words of
hyphenated terms:

(2)Setting Up the Tag-Related File

All verbs are initial capped in heads, including short verbs such as “is,” “was,”
and “be.”

Figure Captions
Initial cap the first word in figure captions:

Figure 1: This is a figure caption.

Table Captions
Cap/lowercase all words except for prepositions, conjunctions, and articles in table
captions:

Table 1: Table Caption for Use as Example

Lists
The first word of an entry in an inline, numbered, or bulleted list should be initial
capped, unless the word is a programming term or variable that normally appears all
lowercase. Try to recast if there is inconsistency.

Following Colons
If text following a colon consists of more than one sentence, or if it is a formal
statement, quotation, or a speech in dialog, the first word should begin with a capital
letter. See Chicago 5.103.

Callouts
The first word in a callout (words added to identify a section of a figure or illustration)
should be initial capped, as well as any words normally capped in text.

Acronyms
Initial cap proper nouns but not generic terms when defining acronyms, such as

I/O (input/output)
LIM (Lotus Intel Microsoft)

C a p i t a l i z a t i o n 11
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Plurals of acronyms carry a lowercase s, such as

PIMs (personal information managers)

There is no reason to italicize any part of an acronym or its spellout, but if you do,
italicize all, including the parentheses.

Numbers and Symbols

Spelling Out Numbers
Spell out numbers ten and under, with these exceptions:

Percentages 5 percent, 20 percent

Numbers less than ten when used with
higher numbers in the same sentence

3 of the 11 files

Math-type numbers 52

Fractions
Simple fractions such as ½ may be used in text without full-size numbers and forward
slash. Compound fractions may be set in either of these ways,

2 ½ inches or 2 5/16 miles

but, built-up fractions must be set with full-sized numbers and not with superscripts, as
shown here:

321
( )x y+

Dimensions
“3×5” is preferred to “3 by 5.” Don’t use the letter x in place of the math operator ×.

Obtain math characters by going to Insert | Symbols, and then using the Symbol font.

Equations
Simple equations—even those containing superscript or subscript numbers—such as
3 + 52 = 28, can remain embedded within the text body (not broken out) with no special
treatment. A complex equation, such as one containing built-up fractions, integrals,
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summations, or square roots, should be broken out and displayed as an inline list. For
further help with math, see Chicago 13.1–53.

Letters as Math Symbols
Uppercase (X,Y): Axes
Lowercase (x,y): coordinates, values, and ranges

Math Operators
In computer text and for common expressions and usage (3×5, 256K×4, 4×4, 24×7, and
so on), use one character space around +, –, and =, and no character space around *, ×,
and ÷, unless the author insists upon a variation of this to emulate how certain
numbers are entered in certain programs.

Verify that an actual minus sign (−) or en dash (–) is used rather than a hyphen (-).
Verify that a multiplication sign (×) is used rather than a lowercase x.

Negative numbers such as −3 are always closed up.

Punctuation and Plurals of Numbers
0’s and 1’s in any context take apostrophes for clarity, but higher numbers don’t; for
example: 0’s, 1’s, 5s, and 6s.

Plurals of numbers are formed by the addition of s alone, as in 240s, 1960s, and ’90s.

Addresses and Phone Numbers

Phone Numbers
Real phone numbers should never be used in example text or art. Where it is necessary
to give real phone numbers (such as for resource lists), have authors double-check for
accuracy.

Example phone numbers should always use a 555 prefix and should be set as
follows:

(800) 555-1212

State Names
Spell out in text but abbreviate (using the two-letter postal code) in columns and lists.
Refer to Chicago 14.17.

Address Terms
“Street” and “Avenue” (etc.) should be written out except in columns and inline lists,
where abbreviations may be necessary to save space.
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ZIP Codes
Refer to U.S. postal codes as ZIP codes. “ZIP” should always appear in all caps.

All real (not example) addresses should include a ZIP code. If a nine-digit code has
been supplied, use this longer version.

Treatment of Computer Terms

General Style Issues
The treatment of the following elements indicates preferred, or most common, usage:

Commands, user input boldface.

Variables, parameters Italics.

Keypresses SMALL CAPS. Simultaneous keypresses are joined
with hyphens, not plus signs, as in ALT-B. (See the
“Keypresses and Key Combinations” section for more
information on keypresses.)

The actual styling will vary slightly from book to book, depending on application or
computer language. This should be established by the PE and copy editor based on
information gathered at the launch meeting and after the first chapter is edited.

Type/Press/Click
Generally, “type” or “enter” is used with words, letters, or numbers to be keyed in.
“Press” is used for any keyboard keys or combination of keys (function keys, letter
keys, or command keys such as TAB) without stating “the key.” For example:

Type your name in the User field.
Enter your birthdate in the DOB field.
Press DELETE. (Not Press the DELETE key.)

“Click” is used to indicate mouse-clicking (double-clicking, right-clicking, etc.) of
onscreen elements such as buttons. “Click on” is acceptable when indicating clicking in
a general area as opposed to a specific element such as a button. For example:

Click the Send button.
Click on the desktop.

14 T r e a t m e n t o f C o m p u t e r T e r m s

Complete Reference / Access 2002: TCR / Andersen / 3241-8 / Front Matter

P:\030Department Share\Production\Forms\PE_styles.vp
Friday, March 02, 2001 9:59:57 AM

Color profile: Disabled
Composite  Default screen



T r e a t m e n t o f C o m p u t e r T e r m s 15

Complete Reference / Access 2002: TCR / Andersen / 3241-8 / Front Matter

Plurals
When adding a plural to a specially treated word (such as italics, bold, or caps), do not
add the treatment to the s, as in

There are five widgets in the preceding program.
The number of reals in a program.
LANs

Abbreviations of Units of Measure
Some of the most commonly used abbreviations include the following:

Measures of Size

Abbreviation Description Example

K Most commonly used as the suffix
for the binary quantity 1024 (210).
640K means 640×1024 or 655,360*

640K

KB kilobyte
10KB means 10240 bytes rather
than 10000 bytes*

10KB

Kb kilobit 10Kb

MB megabyte 200MB

Mb megabit 200Mb

GB gigabyte 400GB

Measures of Speed

Abbreviation Description Example

bps bits per second 64 bps

Kbps kilobits per second 64 Kbps

KHz kilohertz 64 KHz

MBps or MB/ps megabytes per second 10 MBps or 10 MB/ps

Mbps or Mb/ps megabits per second 10 Mbps or 10 Mb/ps

Hz hertz 100 Hz

MHz megahertz 100 MHz

GHz gigahertz 100 GHz

ms millisecond 100 ms or
100 msec

*The difference between K and KB is subtle and should be pointed out to the author if both forms appear in the text.

Units of size are generally closed up, whereas units of speed are separated by a space.
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Capitalization of Elements in Programs,
Operating Systems, and Languages

These generic terms are not capitalized, even when used with proper names:

icon menu mode status bar

title bar toolbar tool view

Capitalization of Filenames, Pathnames, and File Types
Some programming languages are case sensitive, so do not change capitalization of
filenames and pathnames without querying first.

The acronym of file types should be used in text:

Use TIFF (or TIF) files for screen captures.

However, when the dot is necessary, use lowercase:

The .jpg and .gif file extenders are necessary to denote file type.

URLs and FTPs
URLs can be set in boldface or left roman in text (but it’s recommended not to set them
in italics). They may or may not carry the http:// prefix, but they should be consistent.

Hyperlinks are not allowed in manuscript and must be removed by first selecting
the hyperlink and then pressing CTRL-SHIFT-F9.

Keypresses and Key Combinations
Keypresses should always be set in small caps, as in TAB, and should be italic if set in
an italic paragraph, as in the Note below. Avoid excess words surrounding keypresses;
for example, “Press the DELETE key” should instead be “Press DELETE.” Key
combinations should be joined with hyphens, not plus signs:

CTRL-ALT-DEL
SHIFT-F10

Keypresses with no names on them (SPACEBAR, RIGHT ARROW, etc.) should be
formatted as small caps.

Both DEL and DELETE, as well as INS and INSERT, are used, probably because both
spellings are present on a keyboard. Be consistent.
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Menu Selections
Menu selections should be separated with pipe symbols and presented in as concise a
manner as possible. For example, instead of

Select View, then choose Toolbars, then select Formatting.

use

Select View | Toolbars | Formatting.

Be sure to include a space preceding and following each pipe symbol.

Design Elements

Heads
In general, the following rules for heads apply for most standard designs; however,
variances may occur due to book design and content. Check with PE.

■ A chapter should not begin with a head; each chapter should have some
introductory text.

■ Heads should not be “stacked” (for example, an H2 directly below an H1
without some intervening text between them).

■ Heads should not skip from an H1 to an H3 or an H4, but in some cases, such as
in reference chapters, this is allowable.

■ Heads should not be followed directly by a list, unless the book is using a
special format decided at launch.

■ Some designs call for H1s to appear as the running head (in copy); check length
before pages are set.

■ When editing H1s and H2s, consider parallelism—once they appear in the
Table of Contents (TOC) it’ll be too late to change.

When in Outline view, you can check head structure: hierarchy, capitalization, length,
and parallelism.

Special Paragraphs
Special paragraphs (SPs) include Notes, Tips, Cautions, and Remembers, although some
series designs or individual books may include other special paragraphs as well. Special
paragraphs usually carry an icon. Refer to the sample pages for each book for treatment.

It’s best not to stack special paragraphs; it can diminish their impact.
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Inline Elements
Inline elements are set in normal text font and run in the regular flow of text.

■ Inline list Inline lists include single off-set lines. They are never numbered.
If entries are composed of only a few words, then the list is an inline list.
Programming syntax is also set as an inline list.

■ Inline table Inline tables may or may not have column heads. They are never
numbered and they never carry a caption.

■ Bulleted list Bulleted lists are used for nonsequential lists of information. If
each entry is more than a few words and the list as a whole is not a series of
steps, then it is a bulleted list. Lead-in fragments to each bulleted item are
usually boldfaced and followed by an em space (such as shown here), and full
sentences that are lead-ins are usually italicized for emphasis. Set lead-ins
consistently within the list.

■ Numbered list Numbered lists are used for sequences and steps. Numbered
lists may run several pages for lengthy series of steps.

■ Illustrations Unlike figures, illustrations are pieces of art that must be placed
on the laid-out page precisely where they are slugged in the manuscript. They
are usually introduced in the paragraph that precedes the illustration. They
have consecutively numbered slugs in the manuscript but are not numbered in
body text. They do not take captions, although they may have callouts.

■ Listings Code listings are set in monospaced font. They may carry numbered
slugs and numbered references in the text, but usually don’t. Each series design
indicates a specific character limit per line for listings. Some series designs
allow for outdenting listings with longer-than-normal lines.

The only hard return in code listings should occur on the final line; all other lines should
end in a soft return. Also, there should be no tabs in code listings.

Pickup Elements
Pickup elements are set in pages according to the design, generally at the top or bottom
of a page.

■ Tables If a table is referred to elsewhere in the text, it is a pickup table. Tables
are numbered consecutively and have captions. If a subhead occurs in a table, it
should be noted with a Production Directive (PD) before the table. Tables may
be styled only as Normal.

■ Figures Figures are pieces of art that are either referred to more than once in
the text or are large enough that they would create potential layout problems if
placed inline (generally, more than three inches or so high). Figures are
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numbered consecutively and carry captions. They may also have callouts.
Figures that contain multiple pieces of art (for example, two before-and-after
screenshots) should carry a lowercase letter label for each piece, such as a and b,
on the art hard copy.

■ Sidebars/Boxed Text Sidebars are text boxes that most likely float during
layout to another location within the section and therefore should stand alone
and not be dependent on surrounding text. Sidebars usually carry an H2 or H3
that are designated with (s) in manuscript, and may include illustrations and
small inline tables, but not figures, pickup tables, or SPs.

Thumbtabs
Thumbtabs most often carry part titles; PEs check design for style. Note that the TOC is
required by Production in order to generate sample pages—changes to the TOC after
samples are generated must go through Production so that tab copy may be corrected.

Editorial Issues in Page Proofs
The following style issues apply only after the manuscript has been set in page proofs.

Filenames and URLs
Whenever possible, sentences should be edited to avoid awkward breaks of filenames.
Filenames should be broken between recognizable words, and the break should not be
hyphenated. Break after the slash but before the dot:

…file/ (break)
name.ext…

…file/name (break)
.ext…

Heads
Try to make heads no longer than two lines. When breaking heads for sense,

■ Avoid dividing words and separating closely related terms or groups of words

■ Break before prepositions in order to keep prepositional phrases intact

■ Break after punctuation like colons or dashes

■ Strive for evenly broken lines; if not possible, bottom heavy is preferred to
top heavy
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Some examples are shown here:

Embellishing Your Documents (break)
with Artwork and Text Boxes

Using the What’s This? Button (break)
and Finding Out What’s What

Form Letters, (break)
Mass-Mailing Labels, and Lists

Widows
Widows should be fixed when they are shorter than the paragraph indent or are less
than six characters (not including punctuation).

Figures and Pickup Tables
Figures and pickup tables should appear as close as possible after their text references.
To resolve paging difficulties, it’s allowable to place the figure before its text reference,
as long as both are on the same page or spread, and the figure is placed before the next
H1. Inline tables and pickup tables repeat their column heads if a table spills over to a
new page.

Continuation Lines
Continuation lines of captions and heads should appear on all but the first page
of an item. They are styled as follows: lowercase italics, surrounded by italicized
parentheses, such as

Table 1-1. Command Reference (continued)

Continuation lines in indexes should only be used on verso pages and only if they
are absolutely necessary for clarity.

Loose/Tight Lines
For designs with justified text, suggest text edits and not line rebreaks. For designs
with ragged right text, simply flag.

Short Lines
Short lines should be marked for Production to fix, or you can suggest an edit to help
even out line lengths. Short lines often occur with URLs or long file names. See the
“Filenames and URLs” section for breaking suggestions.
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Stacks
Words or word groupings that stack together for three or more lines should be edited
or rebroken to correct the stack.

Thumbtabs
Check against manuscript and sample pages, and also check placement on page and
placement in relation to other pages in the part or chapter.

Treatment of Individual Words
If an author consistently treats a term differently than what appears in the following
list, and it is not incorrect (for example, linefeed instead of line feed), we honor the
author’s usage.
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3-D or three-dimensional
64K (see the footnote in the

“Abbreviations of Units of Measure”
section)

64KB (kilobytes)
4Kb (kilobits)
40MB (megabytes)
10GB (gigabytes)
3 ½-inch disk
24/7, 24-7, or 24×7)

acknowledgment
aka (no periods)
A.M./P.M. (small caps)
appendixes

back up (v), backup (n, adj)
Bézier
bitmap (n), bitmapped (adj)
Boolean
boot up (v), bootup (n, adj)
bps (bits per second)

CD-ROM (compact disc–read-only
memory)

cannot

check box (n)
checklist (n)
check mark (n)
copy-protected (adj)
coworker
cpi (characters per inch)
cross hairs
cross-reference (n, v, adj)
cutoff (n, adj)

data (singular and plural)
database
degrees (not symbol)
desktop
disc (CD-ROM and optical)
disk (not diskette—as in floppy or hard)
double-check
double-click
downtime
dpi (dots per inch)
drag-and-drop (v)
drive A:
drop-down (adj)

e-mail (n, adj, v)
equal sign
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fax
field name
filename
floppy disk
flowchart
flyout (n, adj.)
follow up (v), follow-up (n, adj.)
form feed
FTP (as acronym)

GIF (graphics interchange format)
gray

handheld (n), hand-held (adj.)
hard disk (n, adj)
hard-wire (v)
home page (n)
hostname
hot key (n), hot-key (v, adj)
hot list (n)
Hz (hertz)

ID
indexes
inline

KHz (Kilohertz)
keypad
keypress
keystroke
keyword

laptop
left-click
left-justified
left-justify (v)
leftmost
line feed
log in, log into (v), login (n, adj)
log off (v), logoff (n, adj)
log on, log onto (v), logon (n, adj)
long-distance (adj)
lookup (n)

lowercase
lower-left corner
lower left-hand
lpi (lines per inch)

MHz (megahertz)
MS-DOS
multianything (except words beginning

with i: multi-interests)

notepad (generic) but Notepad (the
Microsoft accessory)

offline
OK
one-dimensional
online
onscreen
on-the-fly
overwrite

palmtop
pathname
percent
placeholder
plug-in (n)
P.M./A.M. (small caps)
pop up (v), pop-up (adj)
predefined
print out (v), printout (n)
pull-down (adj)

read-only (adj)
real time (n), real-time (adj)
reboot
right-click
right-justify (v), right-justified (adj)
rpm (revolutions per minute)
rundown
run time (n), run-time (adj)

salesperson
screensaver
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scroll bar
set up (v), setup (n, adj)
shareware
SHIFT-click
shortcut (n, adj)
sign on (v), sign-on (n, adj)
spell check (v, n)
SQL (takes “a” or “an,” depending

on how pronounced)
stand-alone (adj)
start up (v), startup (n, adj)
subanything
supercomputer

third party (n), third-party (adj)
three-dimensional (adj) or 3-D
toolbar
toolbox
top-left corner
top-right corner
touch-tone (adj)
trade-off

UNIX/Unix (author-dependent)
upper-left corner

uppercase (n, v, adj)
upper left-hand (adj)
URL (uniform resource locator) takes “a”

or “an,” depending on how
pronounced

U.S. (spell out if used as a noun)
user-defined

versus or vs. (both OK)
videodisc

Web (n), web (adj)
wildcard (n, adj)
Wizard or wizard
worksheet
workspace
workstation
write-protect

X axis (n), X-axis (adj)

Y axis (n), Y-axis (adj)

zeros
ZIP code
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